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Multiple model tips 

Q1. A single model has been post-processed. How can the same post-processing be 

applied to a different single model? 

Step 1: Save 

settings file 



LS-DYNA ENVIRONMENT 

[back to contents] 

Multiple model tips 

Q1. A single model has been post-processed. How can the same post-processing be 

applied to a different single model? 

Step 3: Read 

settings file 

Step 2: Start new 

D3plot session with a 

different model 
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Multiple model tips 

Q2. How can I do that without having to browse for the settings file? Method 1: 

Step 1 – Write the dialog box command to read a settings file in a “command file”: 

 

 

Step 2 – Add a new shortcut linking the command file to the F1 key (or you could use any 

other keyboard key): 

 

  

/UTILITIES SETTINGS READ H:\DATA\DEMO\THIS_MULTI_OCC\pp_single_model.set 

Step 3 – In the Shortcuts menu, press 

“Save to Preferences” 
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Multiple model tips 

Step 4 – Open any model, press F1 to 

apply the settings. 

 

 

  

Press F1 
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Multiple model tips 

Q2. How can I do that without having to browse for the settings file? Method 2: 

Step 1 – Copy the settings file into the folder containing the new model 

 

Step 2 – Open the model. The settings file will be applied automatically. 
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Multiple model tips 

Q3. A single model has been post-processed. How can I add more models into the same 

session in order to compare the results?  

 

Step 1: File=>Open New Model 
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Multiple model tips 

Q3. A single model has been post-processed. How can I add more models into the same 

session in order to compare the results?  

 

Step 2: BEFORE BROWSING FOR THE MODEL, tell D3PLOT that you want the new 

model opened in the same windows as the existing model (not in a “next” window), and 

request T/HIS to make the same curves as for the existing model: 



LS-DYNA ENVIRONMENT 

[back to contents] 

Multiple model tips 

Q3. A single model has been post-processed. How can I add more models into the same 

session in order to compare the results?  

 

Step 3: Browse to find the new model. D3PLOT automatically generates graphs, and puts 

the new model in the same windows. You will need to set colour-by-model for the new 

model. If the views have been changed, re-read the settings file. 
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Multiple model tips 

Q4. In graphs of results from multiple models, how do I know which graph is for which 

model?  
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Multiple model tips 

Q5. Is there an easier way to compare multiple models, where the same post-processing is 

required each time I compare? 

 

Step 1: Post-process multiple models (the maximum number of models that you will want to 

compare in future). Write a settings file. 
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Multiple model tips 

Q5. Is there an easier way to compare multiple models, where the same post-processing is 

required each time I compare? 

 

 

Step 2: When opening a new 

session of D3PLOT, don’t 

immediately choose a model. 

Instead, use the option “start 

from settings file”. 

 

The models to be compared 

can now be selected. 
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Multiple model tips 

Q6. How can I tell D3PLOT to make several particular images each time I post-process? 

Step 1a – Work in D3PLOT to make the 1st image. Record settings file pic1.set. 

Step 1b – Work in D3PLOT to make the 2nd image. Record settings file pic2.set. 

Step 1c – Work in D3PLOT to make the 3rd image. Record settings file pic3.set. 

 

Step 2 – In a text editor, create a command file: 

 

 

 

 

 

 

Step 3 – Add a new shortcut linking the command file to the F1 key (or you could use any 

other keyboard key). Save shortcuts to preferences (same as Question 2). 

 

Step 4 – Press F1 to post-process. 

 

  

/UTILITIES SETTINGS READ path\pic1.set 

/image jpeg pic1.jpg 

/UTILITIES SETTINGS READ path\pic2.set 

/image jpeg pic2.jpg 

/UTILITIES SETTINGS READ path\pic3.set 

/image jpeg pic3.jpg 
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Further information 

• In Version 11.1, there is a bug affecting settings files that can 

sometimes cause D3PLOT to crash. To work around this bug, we 

recommend to work in the following order: 

– Open all the D3PLOT windows and arrange their contents. 

– Open T/HIS from within D3PLOT and arrange the graphs 

– Record settings file. 

 

The bug may occur if you work in this order:  

- Open some D3PLOT windows and arrange their contents. 

- Open T/HIS from within D3PLOT and arrange the graphs 

- Open more D3PLOT windows and arrange their contents. 

- Record settings file <= this settings file may be corrupt 

 

x 
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Export Model Properties 

How can the properties in one model (colour, blanking, transparency, ...) be copied 

to another? 

1. Set up blanking, 

colours, etc in one 

model.  
2. Right-click on the 

model in the Part Tree, 

use Export.  

In this example, 4 similar models 

have been read into 4 separate 

windows.  
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Export Model Properties 

Note that the view is a property of a window, not of a model, 

therefore it cannot be exported from the Part Tree. 

 

To make the views the same across all windows – right-click 

on square in top-left corner, “Export view”  

 

A new alternative is to use shortcut 0 (zero key), when the 

mouse is in the window that has the “correct” view. 
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Export Model Properties 

Alternative method - export button is also available on menu tabs – exports 

from the active model or window (green tab) to all models or windows. 

1. Blank parts in 

Model 1 

2. Use Export button in 

Blanking menu 

3. The same parts are 

blanked in Model 2 
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Saving and Reloading Properties 

Sets of properties (colour, blanking, 

transparency, ...) can be saved and 

restored at any time. These are 

saved to the properties (*.prp) file, 

which in Version 11 can also be used 

by Primer.  
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User Defined Components 

• User-defined data 

components for contour 

plots 

• Example 1 – 

displacement in a local 

axis system 

• The local Z displacement 

will be calculated by a 

formula from the global X 

and Z displacements. 

Name of 

component 

In this example, 

we calculate a 

single value for 

each node 

The method used is a simple 

formula, using maths operations, 

numbers, and existing data 

components. Here, DX means x-

displacement, DZ means z-

displacement 

Explanation & data 

components listed here 
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User Defined Components 

Having defined the data component, we can now select it 

in the Data menu.  
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Material properties 

• Material properties of parts can be contour plotted, used in user-defined 

components and written out from the WRITE menu. 

• These come from the ZTF file created by Primer. 

An example of its use could be to create a user defined 

component to plot stress / yield. 
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Contour Options 

Finding which elements have a particular contour level:  

Hover over a contour colour. 

The mouse symbol changes 

to CONT OPTS. Left-click to 

display only those elements 

which have that contour 

level, or right-click to see 

more options: 
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Contour Options 

Finding which elements have a particular contour level:  

These options use the 

existing “Limiting Values” 

capability; this menu 

appears automatically when 

you click on a contour bar. 

Result of left-click on 

contour bar: only the 

elements with that contour 

level are displayed. 
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Contour Options 

To see these elements in 

context, draw the other 

elements in Outline 
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Measure 

• In previous versions of D3PLOT, only one “Measure” could be 

displayed. From Version 10, up to 100 “measures” may be 

defined. Each time the user clicks on another pair of nodes, a 

new “measure” is created. 

• The panel shows the status of the “current” measure, which is 

drawn in a thick black line. 

 Control which 

Measure is 

“current” 

Delete or 

Modify the 

current 

Measure 
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Measure 

Formatting 

options 

• The “measure”s remain visible until deleted.  

• The measurement data (distance) is updated automatically 

when a different time-state is loaded. 

• To remove all the “measure”s from the screen, press Delete All 

in the Measure menu, or press the Delete key on the keyboard. 
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Measure 

The measurements can be exported as time-histories to T/HIS via 

XY_DATA. 

Separate curves are written for difference in X, Y, and Z-

coordinates, and distance magnitude: 4 curves for each pair of 

nodes. 
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Measure 

My text file 

Distance is:    -522.309 -317.057 122.40 
CTRL-C 

CTRL-V 

Measurements in the measure panel can be copied and pasted. 
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Quick Pick 

• Quick-Pick option Information gives 

details about Parts or other entities: 

Part ID, Part title, thickness, 

material type, density, Youngs 

Modulus, etc. 

 

• Material data and material type are 

not included in LS-DYNA’s output 

files, but are passed to D3PLOT by 

the ZTF file that can be written by 

Primer.  
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Quick Pick 

• Quick-Pick option Find sketches the 

entity with a cross-hair. This is 

intended to help locate small 

entities within a large model. 

 

• Press ‘Del’ key to remove the 

cross-hair. 
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Image Matching 

The view can be automatically calculated to match a background image or movie. 

 

For a good match, points should be 

selected at a range of depths (i.e. not 

in a plane).  

 

Select pairs of points on the 

image and model and 

D3PLOT will calculate the 

view. 
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Useful Shortcuts 

• “K” resets entity visibility switches to default settings, or to 

preference settings if any. 

 

• “X” then “N” to pick a node for cut-section. “D” to drag cut-section. 
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Useful Shortcuts 

Caps Lock allows 
dynamic viewing in 
one window to 
control other 
windows 
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Useful Shortcuts 

Up and Down arrow keys to cycle display of models 

Two models in one 

window 

Cycle between the two 



LS-DYNA ENVIRONMENT 

Ergonomics 



LS-DYNA ENVIRONMENT 

[back to contents] 

Resizing Right Hand Menu 

D
ra

g
 

The right hand menu 

area can be dragged 

wider – e.g. to reveal 

long part names in the 

Part Tree 

 

 

This also allows the 

Tools menu buttons to be 

re-arranged, so more 

height is available for the 

docked menus  
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Ergonomics 

Floating menus can be dragged outside the main D3PLOT window. 

Useful with wide-screen or dual-screen monitors. 
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Ergonomics 

Drag 

To do this with the 

Part Tree, undock it 

first 
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Ergonomics 

Now the Part Tree is 

always available without 

obscuring other menus 
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Tuning Graphics Performance 

• D3PLOT can be tuned to take advantage of the 

capabilities of new graphics cards – typically for 

hardware manufactured from about 2007 onwards. 

 

• These should be turned on by default in v11. 

 

• Speed of animation of large models can be 

increased up to 5x or more on some graphics cards 

 

• Instructions for doing this are given in the “Explain 

this” button. 

 

• After tuning the performance, the settings can be 

saved to the preference file. 
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What’s new? 

A presentation describing the new features in the current version of D3PLOT can 

be accessed in pdf format from the Help->What’s New menu. 
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